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Preface

This implementation guide provides information and instructions to help you 
implement Oracle Fulfillment Services, a member of the Oracle E-Business Suite of 
applications, Release 11i.

Intended Audience
This guide is to be used by experienced system administrators and Oracle 
implementation consultants who understand Oracle applications. You must have an 
understanding of Oracle CRM and ERP applications before proceeding.

How This Guide is Organized
The first chapter is an Introduction to Fulfillment Services, including the concept of 
fulfillment and some of the key benefits to using Fulfillment Services.

The second chapter details the technology requirements and dependent 
applications, both required and optional for implementing Oracle Fulfillment 
Services.

The third chapter is an implementation overview describing the basic components 
of an implementation.

The fourth chapter gives the detailed steps required for completing an 
implementation.

The fifth chapter provides detailed steps for optional Administration Setups.

The sixth chapter gives the steps to creating a user of Fulfillment Services.
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How to Use This Guide
This Guide is designed as a start to finish set of steps for implementing Oracle 
Fulfillment Services. Please read the Implementation Overview chapter to 
familiarize yourself with general concepts that will be used throughout the Guide, 
then follow the process outlined in Implementation Steps. Additional 
implementation information is contained in Administration Setup and User Setup.

Related Documentation and Resources
The following documents provide additional information on installing and 
implementing other Oracle E-Business Suite applications.

Installing Oracle Applications, Release 11i
This manual documents the Rapid Install installation process.

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. 

Oracle Applications Flexfield Guide
This guide contains information about using Oracle Flexfield features. It also offers 
flexfield implementation suggestions.

Oracle Applications Product Update Notes, Release 11i
This document contains information about new product features and functions for 
various Oracle applications.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage processing. 

Oracle Applications User’s Guide
This guide explains how to customize lists of values (LOVs) in the system, enter 
data, and introduces other basic features of the GUI available with Oracle 
Applications Release 11i.
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Additional Product-Related Documentation

Implementing CRM Applications
This document provides instructions for completing installation of Oracle Customer 
Relationship Management (CRM) products.

Implementing Oracle HRMS
This document provides the information necessary to implement Oracle HRMS.

Oracle CRM Foundation Implementation Guide
This guide describes set up and configuration tasks for all the foundation 
components.

Oracle CRM Foundation Technical Reference Manual
This manual contains table and view descriptions for all the Oracle CRM 
foundation components.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Fulfillment Services 
working for you. This team includes your Technical Representative, Account 
Manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle8i server, and your hardware 
and software environment.

Oracle MetaLink
Oracle MetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With Oracle MetaLink, you can obtain 
information and advice from Top Tech Documents and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts
You should check Oracle MetaLink alerts before you begin to install or upgrade any 
of your Oracle Applications. Navigate to the Alerts page as follows: Top Tech 
Documents/ERP Applications/Applications Installation and Upgrade/Alerts.
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Self-Service Toolkit
You may also find information by navigating to the Self-Service Toolkit page as 
follows: Top Tech Documents/ERP Applications/Applications Installation and 
Upgrade.
xii                                                                                
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Fulfillment Services Overview

1.1 Introduction
Fulfillment is defined as an automated way to send information to customers. It 
provides the ability to immediately satisfy a customer’s request for information, 
literature, and other correspondence. For example, Customer Service 
Representatives handle a variety of requests ranging from product and service 
inquiries, pricing questions, billing inquiries, and general customer case issues. 
Many of these requests will result in dissemination of literature, collateral, forms of 
application, letters or correspondence to the customer. Oracle Fulfillment Services 
provides the ability for call center administrators, mobile field representatives, 
marketing managers, customer care representatives, and other service agents to 
respond to different customer needs quickly and easily using email and a physical 
channel through Oracle Order Capture.

1.2 Key Features
� Provides automated delivery of information to customers via email.

� Supports scheduling, prioritizing, cancelling, re-scheduling of fulfillment 
requests.

� Ability to recreate and resend preselected fulfillment that was sent in the past.

� Character set support for multiple languages.

� Online content, query creation and management. This powerful feature allows a 
user to create templates with merge fields and preview the created content. 

� Scalable, fault tolerant architecture that balances load among multiple 
fulfillment and SMTP servers. 

� Optionally tracks when email messages are opened by the end user.
rview 1-1



Fulfillment Users
� Collects statistics on malformed messages.

� Ability to mail multiple documents. Ability to send multi-part email messages.

� Optionally updates customer information stored in Interaction History.

� Supports customized email content based on queries of the organization’s TCA 
data.

� Provides a convenient interface for the managing and monitoring fulfillment 
requests.

� Supports standard unsubscribe and suppression functionality.

1.3 Fulfillment Users
Customer service representatives or agents handle a variety of requests ranging 
from product and service inquiries, pricing questions, billing inquiries, and general 
customer care issues. Many of these requests will result in some dissemination of 
literature, collateral, forms of application, or correspondence to the customer.

By using Fulfillment Services, sales and marketing representatives, interaction 
center agents, and service or support personal can focus on each customer’s unique 
fulfillment requirements on a one-to-one basis without spending time managing 
fulfillment output.

An agent using fulfillment can send out information to prospective customers that 
include product announcements, newsletters, lead generation and qualification 
campaigns, and customer service requests. Fulfillment can also be used as the 
mechanism to send out marketing information through marketing campaigns, like 
email blitzes.

1.4 Fulfillment Servers
Fulfillment servers are used to monitor fulfillment requests. Servers are created 
with a name and description and include a shut down time. 

A fulfillment server administrator (or someone who has been designated as the 
server administrator) has the ability to create a new server, update an existing 
server, or restore server attributes for an existing server. Scalability may be achieved 
by adding additional equipment.
1-2 Oracle Fulfillment Services Implementation Guide 



Key Concepts
1.5 Content
Content is a combination of any or all of the following:

� Text

� Graphics

� Merge fields for customized email

� Attachments

1.6 Queries
A query is a SQL (Structured Query Language) statement which collects specific 
kinds of data from the database when fulfilling a request. From the query subtab, 
you can create, update, or restore queries.

Queries are used for generating and populating data in the content automatically, 
through a merge facility. The available fields from the selected query are listed on 
the Template page. 

The first step in creating a query involves identifying the sources needed for the 
query. The query provides merge fields for customizing an email content to its 
intended recipient.

A single query may be associated with more than one template providing that the 
merge field names match the database column names and there is a one-to-one 
correspondence between the number of merge fields and the number of columns 
queried in the SQL statement.

1.7 Key Concepts

Fulfillment Server Group
A Fulfillment Server Group is a group of server instances which process fulfillment 
requests. Users and roles are assigned to Server Groups for processing of requests. 
A Server Group processes the requests of its assigned users and roles before 
processing other queued requests.

Fulfillment Server
A Fulfillment Server is an instance of the request processing software. This is a 
standalone java server that's responsible for merging dynamic content into the 
templates to create customized email message for each recipient.
    Fulfillment Services Overview 1-3



Key Benefits
Mail Profiles
Mail profiles determine many aspects of the outbound email, such as sender’s 
name, sender’s domain, reply address, non-delivery address and whether statistics 
are collected.

Email Server
These are the SMTP implementations supporting the popular email servers such as 
sendmail, LSMTP, and qmail. These are responsible for sending the emails 
generated by the fulfillment servers to the intended recipients.

Templates
Templates are the uncustomized emails which are constructed, generally, as a 
mixture of text and graphics in HTML format. A template is merged with an 
associated query during request processing to creaste customized emails.

Query
A query is a SQL statement which generates selected data from a database. A query 
serves two purposes. The first is to determine which records meet the defined 
criteria. The second is to determine which fields of those records are returned. The 
returned data is merged with a template to create a customized email for each 
recipient.

1.8 Key Benefits
As a key application of the Oracle E-Business Suite, Oracle Fulfillment Services 
offers the following benefits:

� Automate processes – By providing centralized processes and approval 
management, Oracle Fulfillment Services enables an organization to focus more 
on marketing and less on logistics.

� Increase throughput – Oracle Fulfillment Services increases personal 
productivity while facilitating team collaboration and information sharing. 
Marketers can plan and execute campaigns in an accelerated time frame to gain 
a first mover advantage.

� Become a profit center – Because campaigns and offers are tracked across the 
Oracle E-Business Suite, Oracle Fulfillment Services enables marketers to 
pinpoint the revenue generated by each marketing effort.
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Key Benefits
� Maximize ROI – Since costs and revenue can be tracked on a real-time basis, 
marketers can tweak or even stop a campaign in midcourse to maximize the 
marketing ROI.
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Technology Requirements and

Dependencies

The implementation of Oracle Fulfillment Services requires certain technologies to 
be present. This chapter lists those technology requirements, and required and 
optional dependencies.

2.1 Technology Requirements
The following table lists the technology requirements for Oracle Fulfillment 
Services. 
.

Note: For Technological Requirements that overlap with 
Technological Requirements specified in the Oracle Applications 
Installation Guide, the Oracle Applications Installation Guide shall take 
precedence.

Technology

Oracle 8 Enterprise Edition Release, version 8.1.7.2

Apache, version 1.3.9

Java Developer Kit Server Side, version 1.2

JInitiator, version 1.1.8.13

BI Beans, version 1.6.0.36

Oracle XML parser for Java, version 2
ncies 2-1



Required Dependencies
2.2 Required Dependencies
The following CRM foundation modules must be implemented in full. Any 
dependent applications must be set up in full if you have purchased a license for 
that application. If you have not purchased a license, then you need only to set the 
application up to the extent allowed by the shared license which comes free of 
charge with Oracle Fulfillment Services.

2.3 Optional Dependencies
Oracle Fulfillment Services will provide the Deliverables subtab on the Content tab 
if Oracle Marketing Online is implemented. This gives the Fulfillment Services user 
access to content created by users of Marketing Online and the ability to create 
content that may be available to the users of Marketing Online.

Oracle Fulfillment Services also provides the List, Import, Discoverer and Search 
subtabs of Oracle Marketing Online’s Audience tab on its Audience tab. A 
Fulfillment Services user may have access to lists created in Marketing Online and 
the ability to create, search and import lists directly from Fulfillment Services.

MS Internet Explorer, version 5.5 or later

This is the recommended browser for all HTML-based applications.

Application or Module

Human Resources (HRMS)

Technology
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Implementation Overview

3.1 Implementation Description
There are a number of processes which must be completed to implement Oracle 
Fulfillment Services. This chapter gives a brief description of those processes. The 
step by step procedures are detailed in the next chapter, Implementation Steps.

3.1.1 Profile Options
The procedure for setting up and changing profile options is the same for all Oracle 
Applications. For a detailed description of the procedures, refer to the Oracle 
Applications System Administrator’s Guide.

Profile options may be set at four different levels:

Site. The site level setting affects the entire Oracle E-Business Suite.

Application. When a profile option is set this level it overrides the site level setting 
for the particular application.

Responsibility. The responsibility level setting affects users of a given 
responsibility. When a profile option is set at this level it overrides the application 
level setting for users of the particular responsibility.

User. Settings at the user level affect the individual user only. When a profile option 
is set at this level it overrides the responsibility level setting for an individual user.

Note: Profile options belonging to Oracle Fulfillment Services have the 
prefix of AMF. During implementation, profile options relating to 
dependencies may be set as well. 
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Implementation Sequence
3.1.2 Lookups
There are three types of Lookups:

System. System Lookups may not be modified or deleted, and may not have 
additional values added.

Extensible. Extensible Lookups may have additional values added to the list. 
Seeded extensible Lookups may not be deleted.

User. User Lookups are completely modifiable. They may be modified and/or 
added to. Seeded user Lookups, if any, may be modified or deleted.

3.1.3 Administration Options
There are a number of administration options that are associated with the 
individual tabs in Oracle Fulfillment Services. There are also administration options 
which affect multiple tabs. Those administration options are collected under the 
Basic Implementation Chapter.

Many administration options choices are used, throughout the application, to 
populate drop-down menu selections with a list of values (LOVs).

3.2 Implementation Sequence
Summary of Steps needed to Implement Oracle Fulfillment Services.

Note: All levels of Lookups may have their visible value, the text 
displayed to the user, modified.

Step Task Required

4.2 Set System Profile Options Yes

4.3 Enter Lookup Values Yes

4.4 Set up the Fulfillment Administrator Yes

4.5 Create Fulfillment Server Groups Yes

4.6 Configure Fulfillment Servers Yes

4.7 Start the Fulfillment Server Yes

4.8 Configure Email Servers Yes

4.9 Create Mail Profiles Yes
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Implementation Sequence
4.10 Create Queries Yes

4.11 Create Templates Optional

4.12 Create Attachments Optional

5.1 Creating Categories Optional

5.2 Creating Custom Setups Optional

5.3 Deduplication Rules for List Import Optional

6.2 Create the Employee Yes

6.3 Create the User Yes

6.4 Enabling the Application Switchboard Optional

Step Task Required
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Implementation Steps

This chapter covers the set up of Oracle Fulfillment Services. Implementing Oracle 
Fulfillment Services involving the creation of fulfillment servers, email servers, 
assigning sever groups and the assignment of users to server groups. 

4.1 Implementation Task Sequence
The following table describes the order and process of implementing Fulfillment 
Services.

Table 4–1 Task Sequence for Implementing Fulfillment Services

Step Required Description

4.2  Set System Profile 
Options

Yes Set the profile options which are required for your 
implementation of Oracle Fulfillment Services. 
These options become the default settings for the 
Fulfillment Server.

4.3  Enter Lookup 
Values

Yes Lookup values provide the lists displayed when the 
user clicks the lookup icon next to a field.

4.4  Set up the 
Fulfillment 
Administrator

Yes This process creates the Fulfillment Administrator. 
The Fulfillment Administrator is responsible for 
configuring Fulfillment Services. The Fulfillment 
Administrator must have a responsibility of Oracle 
Fulfillment Services Super User assigned to him.

4.5  Create Fulfillment 
Server Groups

Yes Each Fulfillment Server must be assigned to only 
one Fulfillment Server Group. The application is 
designed to allow the creation of a Server Group, 
the creation of a Fulfillment Server and the addition 
of the Server to the Server Group in a single process.
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Set System Profile Options
4.2 Set System Profile Options
These profile options configure Fulfillment Server and adapt it to your system.

Prerequisites
None

Navigation
Log into the Forms instance and select System Administrator Responsibility. 
Navigate to Functions > Profile > System.

Steps
1. Enter a profile name in the Profile Field and click Find. 

2. Enter the appropriate value in the column corresponding to the level indicated.

4.6  Configure 
Fulfillment Servers

Yes If not accomplished in the previous step, each 
Fulfillment Server must be configured 
appropriately.

4.7  Start the 
Fulfillment Server

Yes Each Fulfillment Server must started.

4.8  Configure Email 
Servers

Yes Configure each email server

4.9  Create Mail 
Profiles

Yes Mail profiles are used to configure email 
components such as sender’s name, domain name, 
and various reply addresses.

4.10  Create Queries Yes Queries are required in order customize email 
content to its intended recipient. 

4.11  Create Templates Optional Templates are the body of the email being sent. The 
template may consist of text, graphics, information 
which is related to the recipient and merged from a 
query, or any combination thereof.

4.12  Create 
Attachments

Optional Attachments to a Template are file which are sent as 
an attachment to the individual email. Attachments 
may be files found on the server, the local desktop, 
or from another Oracle application, such as a 
Deliverable created in Oracle Marketing Online.

Table 4–1 Task Sequence for Implementing Fulfillment Services

Step Required Description
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Set System Profile Options
3. Save your work. 

Table 4–2 Profile Options and Settings

Option Required Level Setting Effect/Limitation/Default Value

AMF: Server 
Heartbeat

Yes Site Numeric 
Value in 
Seconds

This is time in seconds after which 
the server performs periodic updates 
to the database and reads new 
property values if any. Optimal value 
is 600 seconds. 

This should not be set to any value 
under 300 as it will adversely affect 
the performance and error recovery. 
Any value greater than 900 will make 
the server slow to respond to 
changes. 

AMF: 
Number of 
Query 
Processors

Yes Site Numeric 
Value

This indicates the number of parallel 
database sessions available to process 
fulfillment queries. A minimum of 3 
is required for fault tolerance, 5 is 
optimal. The higher the value the 
higher the rate at which the queries 
are executed. However this is 
non-linear and will adversely affect 
other database transactions. A value 
of 10 is the recommended maximum. 
There should be at least 5 fulfillment 
servers available in the system to 
utilize this value.

AMF: No 
Customize 
Chunk

Yes Site Numeric 
Value

This is the number of messages 
allocated to each fulfillment server, if 
there are no customizations in the 
message. The optimal value is 5000. 
Lowering this value will increase 
parallelization for the request, 
however this also increases document 
loads from the servers and the server 
processing will not be efficient. This 
value should not be set lower than 
2000. A Higher value lowers the 
parallelization and the speed at which 
this request is handled. This value 
should not be set higher than 10000.
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Set System Profile Options
AMF: 
Customize 
Chunk

Yes Site Numeric 
Value

This is the number of messages 
allocated to each fulfillment server, if 
there are customizations in the 
message. The optimal value is 1000. 
Lowering this value will increase the 
parallelization for the request, 
however this will also increase 
document loads from the servers and 
the server processing will not be 
efficient. This value should not be 
lower than 500. The higher the value, 
the lower the parallelization and the 
speed at which the request is 
handled. This value should not be set 
higher than 2000.

AMF: Insert 
Row Size

Yes Site Numeric 
Value

This value indicates the maximum 
number of rows that can be inserted 
into the data tables in any transaction. 
A value of 100000 is optimal. A 
higher number requires more 
resources, such as rollback segments, 
will be needed to manage the 
transaction. The lower the number, 
the longer it will take to process 
queries and insertions.

AMF: 
Encryption 
Key

Yes Site A text value 
between 5 and 
20 alpha 
numeric 
characters.

If this value is changed, it will not be 
possible to decrypt the data that was 
sent out earlier with a different key.

AMF: 
Default 
Email User

Optional Site User Defined Default username used in sending 
email messages.

AMF: 
Default 
Email 
Password

Optional

Required 
if AMF: 
Default 
Email 
User is 
specified

Site Password of the default email 
username.

Table 4–2 Profile Options and Settings

Option Required Level Setting Effect/Limitation/Default Value
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Set System Profile Options
AMF: 
Default Mail 
Profile

Yes User Select from 
available mail 
profiles

This is the default mail profile used 
whenever the user sends an email. 
However, it is recommended that 
mail profiles are appropriate for 
every request.

AMF: Order 
Type

Yes Site Order type 
from LOV 
supplied by 
Order 
Management

Order type used for Order 
Management when collateral is 
requested.

AMF: Base 
URL

Yes Site Base URL for 
email 
recipients to 
click and 
contact the 
sender via 
their home 
page

This indicates the location of the 
webserver which will host the Oracle 
E-Business suite application. It is 
needed to make sure the hyperlinks 
sent to the customer are properly 
directed back to the sending 
application.

AMF: Is 
Admin User

Yes User Yes/No Profile is used to determine if an 
AMF user is also an administrator.

JTF Home 
Page File 
Name

Yes Appl jtfhomepage. 
jsp

This sets the default home page of all 
fulfillment users to jtfhomepage.jsp 
which is uniform across many 
applications and can be configured as 
required. 

**This is not an AMF profile, but the 
jtfhomepage.jsp value must be 
entered for the Oracle Fulfillment 
Services application.

AMF: 
Default 
Unsubscribe 
Template

Yes Site 50 This is the seeded content item ID 
from Content Manager that will be 
appended to emails to provide a link 
to the Contact Preferences page. This 
should not be changed.

OSO: 
Minimum 
search string 
length

Optional Site or 
User

User Defined The default setting is 0. This profile 
determines the number of characters 
that must be entered before 
performing a search. 

Table 4–2 Profile Options and Settings

Option Required Level Setting Effect/Limitation/Default Value
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4.3 Enter Lookup Values
Verify and create lookups for Fulfillment Services.

Steps
1. Log into Forms and Select Oracle Fulfillment Services Administrator 

responsibility. 

2. Navigate to Functions > Setups > Lookups.

3. Use View > Find to locate the individual keys.

See the table below for Lookups and their types, values, and meanings.

Note: System type keys may not be changed, deleted or added to. 
Extensible type keys may have their visible values changed. User 
type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMF_ACCESS_TYPE System Group

User

Group

User
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AMF_CHARSET_TYPE Extensible Arabic (ISO)

Arabic (Windows)

East European (ISO)

East European 
(Windows)

Greek (ISO)

Greek (Windows)

Hebrew (ISO)

Hebrew (Windows)

Japanese (EUC)

Japanese (Windows)

Korean (EUC)

Korean (Windows)

Russian (ISO)

Russian (Windows)

Simplified Chinese 
(GB2312)

Simplified Chinese 
(Windows)

Thai (Windows/ISO)

Traditional Chinese 
(Big5)

Traditional Chinese 
(EUC)

Traditional Chinese 
(Windows)

Turkish (ISO)

Turkish (Windows)

Unicode (UTF-8)

West European (ISO)

West European 
(Windows)

Arabic (ISO)

Arabic (Windows)

East European (ISO)

East European (Windows)

Greek (ISO)

Greek (Windows)

Hebrew (ISO)

Hebrew (Windows)

Japanese (EUC)

Japanese (Windows)

Korean (EUC)

Korean (Windows)

Russian (ISO)

Russian (Windows)

Simplified Chinese (GB2312)

Simplified Chinese (Windows)

Thai (Windows/ISO)

Traditional Chinese (Big5)

Traditional Chinese (EUC)

Traditional Chinese (Windows)

Turkish (ISO)

Turkish (Windows)

Unicode (UTF-8)

West European (ISO)

West European (Windows)

Key Type Values Meanings
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AMF_CREATE_
EXPIRATION_STATUS

System A

I

Active

Inactive

AMF_EMAIL_SERVER_
TYPE

System IMAP

SMTP

IMAP (not supported in this release)

SMTP

AMF_EMAIL_STATUS System Bounced

Malformed

Opened

Total

Unopened

Unsubscribed

Bounced

Malformed

Opened

Total

Unopened

Unsubscribed

AMF_EXPIRATION_
STATUS

System A

E

I

Active

Expired

Inactive

AMF_PLATFORM System LX

NT

UX

Linux

Windows NT

Unix

AMF_PROCESS_STATUS System Deferred

Failure

In Progress

Partial Success

Success

Deferred

Failure

In Progress

Partial Success

Success

AMF_TEMP_ATTCH_TYPE System Local Local

AMF_TEMP_COMP_TYPE System AMF_Email_
Deliverable

Destined for future use.

AMF_RT_STATUS System Idle

Running

Shutdown

Startup

Idle

Running

Shutdown

Startup

Key Type Values Meanings
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4.4 Set up the Fulfillment Administrator
Create a Fulfillment User with the Oracle Fulfillment Services Administrator (code 
23674) as the default responsibility and Oracle Fulfillment Services (code 882) as the 
default application. Also set the profile option, AMF: Admin User to yes. See 
Chapter 6, User Setup, for additional information. 

4.5 Create Fulfillment Server Groups
Server Groups are composed of Server Instances that form a group. You can create a 
Server Group and the Server Instances at the same time or create the group first and 
then add Server Instances.

Prerequisites
None

Navigation
Server > Server Groups > Create

Steps
1. Enter a Name for the Server Group.

2. Select a Status of Active.

3. Enter a Priority. Priority levels run from 1 to 100 from lowest to highest priority. 
Requests from users assigned to a server of priority 10 will be processed before 
requests from users assigned to a server of priority 1. The priority in this case, 
does not rank the server against each other. It determines which requests will be 
processed in which order. 

4. Enter a Description.

5. Click Continue to create the Server Group and add Server Instances to the 
Server Group or click Finish to create the Server Group so that Server Instances 
may be added later.

Note: when configuring the following servers, Fulfillment and 
Email, select Active for status to make them available for use. Note 
that selecting Active or Inactive will have no effect on physical 
servers.
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6. Clicking Continue will display the Server Group Details page where Server 
Instances may be created and added to the Server group. Users or Roles may be 
added to the User Group Mapping as well.

7. Click Create Server Instance to enter information for the Server Instance.

8. Enter an Instance Name for the Server Instance.

9. The Group Name of the Server Instance will be completed for you. 

10. Select a Status of Active or Inactive. 

11. Enter either a DNS Name or an IP Address for the server instance. If both are 
entered the DNS Name will take precedence.

12. Click Create.

13. Repeat Steps 7 through 12 to add additional Server Instances.

14. To add User Group Mappings:

a. Select User or Role from the Role column. Selecting a User will add a User 
to the Server Group. Selecting a Role will assign all users of that role to a 
Server Group.

b. Click the lookup icon next to the Name column to display a list of Users or 
Roles from which to choose.

15. Click Finish to complete the creation of a Server Group.

4.6 Configure Fulfillment Servers
Server Instances must be attached to a Server Group. Use this procedure only if a 
Server Group has been created and you wish to add Server Instances to it.

Prerequisites
An existing Server Group.

Navigation
Content > Server Instances > Create

Steps
1. Enter an Instance Name for the Server Instance.

2. Enter the name of the Server Group or click the lookup icon to display a list of 
available Server Groups. Select a Server Group.
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3. Select a Status of Active or Inactive.

4. Enter either a DNS Name or an IP Address. If both are entered the DNS Name 
takes precedence.

5. Enter Properties as follows. When a value is scalable, a basis for the value 
supplied is given. 

a. Enable Database logging. Y enables the server to log error or information 
messages into the database. These may be viewed remotely from a JSP. 
N means the system creates log files containing error or information 
messages.

b. Maximum Merge Threads. Not more than 4 for a 266 Mhz Windows NT 
machine. These are the maximum number of threads in the server used to 
create the merged mail messages.

c. Maximum Mailer Threads. This should be set to twice the number of the 
Maximum Merge Threads. These threads are responsible for mailing the 
merged mail messages.

d. Maximum emails sent per hour. Set in thousands per hour with the 
minimum value being 1000.

e. Maximum JDBC connections. The optimal setting is 8. This is the maximum 
allowable number of parallel connections opened per server.

f. Maximum Processing Threads. The maximum value is 2 per server 
instance.

g. Minimum JDBC Connections. One.

6. Click Finish to create the Server Instance and add it to the selected Server 
Group.

4.7 Start the Fulfillment Server

4.7.1 Windows NT Setup

Steps
1. Download and install JDK 1.1.8 or JDK 1.2

2. Create a directory FMS

3. Create a directory FMS\lib
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4. Create a directory FMS\log

5. FTP in binary mode the following zip/jar files into FMS\lib directory, from the 
APPL_TOP/java/ where the Oracle Applications is installed. Copy the apps.zip 
after the Oracle Fulfillment Services patch is installed.

� sax2.zip

� xmlparserv2.zip

� jdbc111.zip

� apps.zip

6. Create a bat file to set the environment variables in the FMS directory, call it 
fmsenv.bat. The following need to be set as follows,

set CLASSPATH=.
set JDK_HOME=<Directory where JDK is installed eg. E:\jdk1.1.8>
set PATH=%JDK_HOME%\bin
set CLASSPATH=%CLASSPATH%;lib\sax2.zip
set CLASSPATH=%CLASSPATH%;lib\xmlparserv2.zip
set CLASSPATH=%CLASSPATH%;lib\jdbc111.zip
set CLASSPATH=%CLASSPATH%;lib\apps.zip
set CLASSPATH=%CLASSPATH%;%JDK_HOME%\classes
set CLASSPATH=%CLASSPATH%;%JDK_HOME%\lib
set CLASSPATH=%CLASSPATH%;%JDK_HOME%\lib\classes.zip
set CLASSPATH=%CLASSPATH%;%JDK_HOME%\lib\classes.jar
set CLASSPATH=%CLASSPATH%;%JDK_HOME%\lib\rt.jar
set CLASSPATH=%CLASSPATH%;%JDK_HOME%\lib\i18n.jar

7. Create a bat file to run the fulfillment server in the FMS directory, call it 
runfms.bat. The following need to be set as follows. All the text after "java" 
should be on one continuous line.

call fmsenv.bat
java -mx128m -DSERVER_UP_TIME=<Server up time in seconds eg. 172800> 
-DLOG_LOCATION=<Full path to the directory where you want the log 
messages eg. E:/FMS/log> -DSERVER_INSTANCE_ID=<Server Instance Id eg. 
10060> -Dframework.Logging.system.filename=Sys 
-Dservice.Logging.common.filename=Apps -DJTFDBCFILE=<Full path to the 
dbc file e.g E:/FMS/lib/crmimp06_mapqar8.dbc> -classpath %CLASSPATH% 
oracle.apps.amf.servercore.ServerCore

It is recommended that the DSERVER UP TIME be set to a minimum of 2 days 
(172800 seconds) and not exceed 5 days (432000 seconds).

Run the fmsenv.bat file to restart the fulfillment server.
4-12 Oracle Fulfillment Services Implementation Guide  



Start the Fulfillment Server
4.7.2 Unix Setup (recommended)

Steps
1. Create a directory FMS

2. Create a directory FMS/lib

3. Create a directory FMS/log 

4. Make sure the write permissions are set correctly enabling fulfillment server to 
create additional files & directories.

5. Set your environment variables by running the relevant script. 

6. Capture the PATH and CLASSPATH values by 

echo $PATH
echo $CLASSPATH

The PATH variable must have the location of a JDK/Bin install.

7. Create a bourne shell script runfms.sh as below and set the PATH and 
CLASSPATH obtained above. All the text after "java -mx128m" should be one 
continuous line.

#!/bin/sh

CLASSPATH="<CLASSPATH value captured above>" e.g.
#CLASSPATH="/oracle/apache/jsdk/JSDK2.0/lib/jsdk.jar:/afrz/crmmkt/code/m
apdev01/java/jdbc12.zip:/afrz/crmmkt/code/mapdev01/java/apps.zip:/afrz/c
rmmkt/code/mapdev01/java/sax2.zip:/afrz/crmmkt/code/mapdev01/java/xmlpar
serv2.zip"

PATH="<PATH value captured above>" e.g.
#PATH="$PATH:/local/java/jdk_1.2.2_05a_prod/bin"

export CLASSPATH
export PATH

java  -mx128m -DSERVER_UP_TIME=<Server up time in seconds eg. 432000> 
-DLOG_LOCATION=<Full path to the directory where you want the log 
messages eg. E:/FMS/log> -DSERVER_INSTANCE_ID=<Server Instance Id eg. 
10060> -Dframework.Logging.system.filename=Sys 
-Dservice.Logging.common.filename=Apps -DJTFDBCFILE=<Full path to the 
dbc file e.g E:/FMS/lib/crmimp06_mapqar8.dbc> 
oracle.apps.amf.servercore.ServerCore
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8. Create a cron job to run this script at regular intervals: 

crontab -e to open a cron job

Please enter the following to run this script every hour.

0 * * * *  <FULLPATH to runfms.sh>/runfms.sh

4.8 Configure Email Servers
The physical email servers that will be used to send outbound emails must be 
configured under the Email Servers subtab. 

Prerequisites
None

Navigation
Server > Email Servers > Create Email Server

Steps
1. Enter the Name of the Email Server.

2. Select SMTP as the Type of server.

3. Select a Status of Active or Inactive.

4. Enter a DNS Name or an IP Address. If both are entered, the DNS Name takes 
precedence. 

5. Enter the Port number for the server. The default is 25.

6. Select a Platform for the server: Linux, Unix, or Windows NT.

7. Select the Is Secure checkbox if the server encrypts outgoing transmissions.

8. Enter a Description.

9. Click Apply to create the server.

4.9 Create Mail Profiles
Mail Profiles determine how mail is return addressed, which domain it is sent from 
and other parameters. A Mail Profile will be selected when a request is made.
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Prerequisites
None

Navigation
Server > Mail Profiles > Create Mail Profile

Steps
1. Enter a Name for the Profile.

2. Select a Status of Active or Inactive.

3. Enter a Description. 

4. Click Apply to create the Mail Profile and return to the Mail Profiles summary 
page. Click Continue to add Profile Properties.

5. Enter values for the following Properties. To remove the value, clear the field.

a. Mail From Domain. Enter the domain where the email is sent from.

b. Bounce Back Address. Enter the address, at the Mail From Domain, where 
bounce backs should be sent.

c. Reply To Address. Enter the address, at the Mail From Domain, where 
recipient replies should be addressed.

d. Send Multipart Emails. Enter Y to have email sent in Text and HTML 
formats so the recipients mail client can display the text version if HTML is 
not available. If set to N, only the HTML version will be sent.

e. Mail From User. Enter the address, at the Main From Domain, which should 
appear in the From line of the email.

f. Enable Statistics Collection. Enter Y to have statistics collection. In the 
current release only Open statistics are collected from HTML emails. 
Statistics are not collected from text only email.

g. Include Unsubscribe Template. Enter Y to append the standard unsubscribe 
template with the unsubscribe URL to every email message. Only messages 
sent to lists and parties will have this link appended at the end. 

4.10 Create Queries
Queries are created on the Content tab and provide the data to customize email to 
its recipient.
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Prerequisites
None

Navigation
Content > Query > Create

Steps
1. Enter a Name for the query.

2. Enter a Description for the query.

3. Enter the SQL statement to produce the desired records from the database. A 
SQL statement may be designed to retrieve records from a list created in 
Discoverer.

4. Click Create to save your work.

Query Limitations
The Email Address Column must be named: emailaddress

The Fax Address Column must be named: faxaddress

The BLOB and CLOB columns must not be selected in the query.

There must be no spaces in the column aliases. For example, "Customer Name".

4.11 Create Templates
See the Oracle Fulfillment Services Users Guide for information on creating templates.

4.12 Create Attachments
See the Oracle Fulfillment Services Users Guide for information on creating and 
attaching attachments.

Note: If logging interactions into Oracle Interaction History, add 
the following to the query: ’P’ Customer_Type, party_id customer_
id. There should not be any colons (:) in the SQL statement except 
for the Bind Variable. The select columns should not exceed 50.
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Administration Setup

This chapter details creating Custom Setups for Deliverables and Audience if 
Marketing Online is implemented as an optional dependency. While Custom Setups 
for Deliverables may have already been setup, these are the steps to create 
additional Custom Setups which may be suitable for email deliverables.

5.1 Creating Categories

Use
Categories are used to group like objects. Most of the Categories for deliverables 
have been seeded. Use these steps to create additional categories for deliverables.

Deliverables
Categories are used by deliverables to group them together. When creating a 
deliverable, a category is required. Examples of deliverable categories are: 

Note: Deliverables and Audience appear only if Marketing Online 
has been implemented.

Step Required Description

5.1  Creating Categories Optional Create Categories for Deliverables.

5.2  Creating Custom 
Setups

Optional Create setups for Deliverables.

5.3  Deduplication Rules 
for List Import

Optional Create Deduplication Rules for importing list 
entries.
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Collateral, Creative, or email. Additionally you may create subcategories to further 
define a deliverable.

Prerequisites
None

Navigation
Marketing Online > Administration > Marketing > Setup > Categories.

Steps
1. Click Create.

2. Enter a Category Name.

3. Select a Parent Category if desired.

4. Select the Enabled checkbox to make the Category available.

5. Select Deliverable from the Created For drop-down menu.

6. Enter a Description.

7. In the case of deliverables, make sure the parent–child relationship is captured 
correctly.

8. Click Create.

5.2 Creating Custom Setups

Use
A Custom Setup reflects how an organization will use a Deliverable. A custom 
setup determines the Activity Type and Activity associated with a Deliverable and 
which items appear on the Side Navigation Menu when a Deliverable is created or 
edited.

Side Navigation Menu
This is the vertical menu which appears on the left hand side of the page, once an 
object is created or when it is edited.

Menu Items
 These are the components available for Deliverables:
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� Main

� Attachments

� Budget

� Costs and Revenues

� Metrics

� Email Content

� Deliverable Kit

� Inventory Options

� Tasks

� Notes

� Team

Each of the menu items refer to a different page. Menu items are the functional 
areas within the application where data can be created or object details viewed. 
While some of the menu items have functional implications, others are used for 
information purposes only. The Main item is displayed when an object is first 
accessed.

Component Groups
Each of the menu items are logically grouped into various sections based on 
functionality. Component Groups for Deliverables include Planning and 
Collaboration.

Navigation
Marketing Online > Administration > Marketing > Setup > Custom Setup

Steps
1. Click Create.

2. Associate the Custom Setup with a Deliverable marketing object.

3. Select an Activity Type for the Deliverable. For email deliverables, select an 
Activity Type of Email. 

4. Select an Activity.

5. Mark Active – Only Active custom setups will show up at object creation.
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6. Set Suffix - The suffix set here is reflected when an object is created. The suffix 
can be alpha, numeric or a combination. The maximum number of characters in 
a suffix is three. This field is optional.

7. Select Menu Items.

The option to select menu items appears when a custom setup is created.

The combination of menu items show up based on the Object, Activity Type, 
and Activity combination. 

a. Select a Component Group from those listed above.

b. Select a Display Sequence. This dictates the order in which the menu items 
are displayed within a component group.

c. Select Components. These are all the menu items available to be selected. 
These are seeded within the application. Menu items not shown are not 
available. In order to be used for Fulfillment Services, the Email Content 
component must be selected.

d. Available Attributes. Components may be selected or deselected on the 
basis of these checkboxes. Deselected menu items do not appear on the 
object side panel menu.

e. Mandatory. Once components are made mandatory, those components 
cannot be disabled. The only recourse would be to inactivate the custom 
setup and create a new one with modified components and criteria.

f. Show in Reports. This checkbox will decide the attributes shown in the 
portals and for locked objects.

g. Approvals. Approvals can be selected or deselected for Theme and Budget. 
Objects using custom setup with ‘Theme’ and ‘Budget’ disabled do not go 
through approval process. Theme and Budget approval can be selected or 
deselected independent of each other. Please refer to Creating Approval 
Rules for more information on the approval process.

Custom setups are selected from the respective create object pages. While some 
custom setups are seeded, additional setups may be created or existing setups may 
be modified to meet the organization’s Business Rules.

5.3 Deduplication Rules for List Import
a. Log into Marketing Online.
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b. Navigate to Administration > Marketing > Audience > Deduplication 
Rules.

c. Enter a Rule Name, Description and select a Type from: Import Consumers, 
Import Organizations or List. The Type determines when the rules will be 
applied.

d. Click Update.

e. Click the link of the rule just created.

f. Select a table column for this rule to check for duplicates.

g. Click Update. Select additional columns if required.

h. Click the Deduplication Rules link to return to the Rules List.
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User Setup

Users of the Oracle Fulfillment Services are created using the following steps. As it 
is likely that other Oracle applications have been implemented and users already 
created, please check carefully for the existence of a user or an employee before 
setting up a new user.

Steps

6.1 HRMS Navigation
The responsibilities and navigation paths are different for the Oracle HRMS and 
Shared Oracle HRMS. See below for Responsibilities and base Navigation paths for 
each.

Note: You must perform these steps in this order shown. 

Step Required Description

6.1 HRMS Navigation N/A This section describes the navigation paths 
used to set up employees in the next step.

6.2 Create the Employee Yes Users are associated with employees and 
therefore must be created first.

6.3 Create the User Yes These are the steps to create a user of 
Fulfillment Services.

6.4 Enabling Default
      Responsibilities

Yes Users of Fulfillment Services are likely to have 
access to multiple Oracle applications. This 
section contains steps to set a default 
responsibility for a user.
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This section describes the creation of Users for Fulfillment Services.

6.1.1 With Full Oracle HRMS
Responsibility: HRMS Manager

Navigation: People > Enter and Maintain

6.1.2 With Shared Oracle HRMS
Responsibility: CRM Administrator

Navigation: CRM Foundation > Resource Manager > Maintain Employees > 
Employees

6.2 Create the Employee
A user of Oracle Fulfillment Services must be an employee first in order to be set up 
as a user. Follow these steps to create a new employee.

Prerequisites
None

Steps
1. Log into forms.

2. Select appropriate HRMS Manager Responsibility.

3. Navigate to People > Enter & Maintain.

4. In the Find Person box, enter a full or partial last name for the employee 
followed by a "%" and click Find. If the person is found, click OK and close the 
form. Proceed to section 6.3.

If the person is not found, continue with the following steps.

5. Enter the following information:

Note: If you have the full installation of Oracle HRMS then you 
cannot create employees under CRM Foundation > Resource 
Manager > Maintain Employees > Employees. You will receive an 
error message indicating that you must use HRMS.
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� Last Name and First Name

� Title (courtesy title: Mr., Ms.)

� Gender (will populate based on title, if possible)

� Type = Employee

� Social Security # (will be checked against existing SS#)

� Birth Date

6. Save your work. A confirmation will appear in the lower left corner of the 
window.

6.3 Create the User
You will create the user based on the employee created in the previous section.

Prerequisites
Create an Employee in HRMS.

Steps
1. Log into Forms under the SysAdmin login.

2. Navigate to Security > User > Define.

3. Click View > Find and enter a full or partial last name followed by a "%". Click 
Find. If the user is found, skip to Step 7. If the user is not found, continue with 
the following steps.

4. Create a new user.

5. Assign the employee created in Step 1 to the user. 

6. Assign appropriate responsibilities to the user. If Oracle Marketing Online is 
implemented, the responsibility will be Fulfillment Services Super User. If 
Oracle Marketing Online is not implemented, the responsibility will be 
Fulfillment Services Core User. See Step 7 for responsibility codes. 

If Fulfillment Services is not the default application for the user, enter a 
Fulfillment Services responsibility here, save your work, close the form, and 
skip to section 6.4.
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If Fulfillment Services is the default application for the user or if the user did 
not exist, enter a Fulfillment Services responsibility here. Save your work and 
close the form.

7. Set Profile Options:

a. Navigate to Profile > System.

b. Enter user name just created.

c. Search for profile JTF_PRO%.

d. Set JTF_PROFILE_DEFAULT_APPLICATION equal to 882 in the User 
column.

e. Set JTF_PROFILE_DEFAULT_RESPONSIBILITY equal one of the following 
codes:

� Oracle Fulfillment Super User, code 23434

� Oracle Fulfillment Core User, code 23698

� Oracle Fulfillment Services Administrator, code 23674 (for use in the 
forms environment only)

8. Save your work.

9. Import the employee as follows:

a. Change responsibility to CRM Administrator.

b. Navigate to Resource Manager > Maintain Resources > Import Resources.

c. Locate the employee just created. Enter employee’s name in the name fields 
and click Search.

d. Click Create Resource.

e. Click OK to accept default values.

f. Click Save Resource

g. Click Details.

Note: The Oracle Fulfillment Core User has no Oracle Marketing 
Online responsibilities and will not see the tabs and subtabs 
(Deliverables and Audience) provided by Marketing Online.
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10. Specify Roles and Groups. 

a. Assign a Role of Sales Representative.

b. Assign a Group of Sales and Marketing.

6.4 Enabling the Application Switchboard
Performing these steps will enable users to enable the Application Switchboard and 
allow a user to select a different application after logging into their default 
application.

Prerequisites
None

Steps 
1. Log into the admin console using the ’SYSADMIN’ account.

2. Navigate to Settings > Site Preferences > Interapplication Bar > Navigation 
Group Setup.

3. Enter a Group Name.

4. Enter a Description for the group.

5. Leave Status as Active.

6. Enter a value for the Display Order.

7. Click Update.

8. Click the Details icon to the right of the Group Name or click Navigation Group 
Details from the Side Navigation Menu.

9. Select the Application for the group.

10. Click Update.

11. This will create an application navigation list across the top of the screen. Click 
the application name to switch between two or more applications.
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Acronyms

This appendix provides a list of acronyms used throughout this Guide. For 
additional information please see the Glossary in Appendix B.

DNC Do Not Call. A flag in marketing databases and lists indicating people 
who do not wish to be contacted.

DNS Domain Name Service

GUI Graphical User Interface.

HTML HyperText Markup Language.

HRMS Human Resources Management System.

IMAP Internet Mail Access Protocol

IP Internet Protocol

JSP Java Server Page.

LOV The List of Values is a list that appears in various drop-down fields within 
OMO. These List of Values can be predefined or created from user entered 
information.

ROI Return on Investment.

SMTP Simple Main Transfer Protocol.

SQL Structured Query Language. Used to query databases.

URL Universal Resource Locator.
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Glossary of Terms

This appendix provides a Glossary of Terms used throughout this guide.

Attachment
A file or URL attached to a marketing object.

Audience
The audience tab provides functionality relating to List creation, management and 
the creation and management of information relation to parties external to the 
organization.

Bind Variable
A Bind Variable is a placeholder for a value in a SQL query.

Customer
A prior purchaser of products or services.

Deliverable
A unit of marketing information to be given to a Customer or Prospect. Deliverables 
may be in hard form, e.g., a flyer or printed information, or in soft form, e.g., an 
electronic brochure or email attachment.

Discoverer
Oracle Discoverer is a data mining tool allowing users to query databases without 
knowing SQL.
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Dserver Uptime
This is the time in seconds in which the server instance should run before being 
restarted.

Email Server
A SMTP email server is used to deliver email to the Internet.

Field
A unit of data. Data is stored in an array of records and fields. A field on a Page is 
where data is entered or selected from a LOV.

Fulfillment User
A Fulfillment User is a user which places create email templates or places 
fulfillment requests for distribution of email through Oracle Fulfillment Services. 

Fulfillment Server
A Fulfillment Server is a standalone java server which merges a template with 
query information to create customized emails. These emails are then sent to the 
email server.

Home Tab
The Home tab is the first tab the user sees when they log onto Marketing Online. 
The Home tab contains a number of bins and available reports as well as links in 
certain bins to recently accessed marketing objects.

A qualified prospect for the sale of products or services. A lead may result from the 
prospect contacting the organization or by the organization contacting the prospect. 

Interaction
A touchpoint with a customer or potential customer. Interactions may be recorded 
in Oracle Interaction History.

IP Address
An Internet Protocol Address is a numeric value which identifies a device 
connected to or addressed from the Internet.

Link
A hyperlink to another Page.
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Mail Profiles
A collection of information used to construct email, such as sender’s name, sender’s 
domain, reply address and whether statistics are collected.

Multi-Part Email
Multi-Part emails are those which contain both text and HTML components. In this 
way email clients which are capable of reading text only may read the text portion 
and those email clients which are capable reading HTML may read the HTML 
portion. Using a Multi-Part email ensures that the email recipient will be able to 
read the message content regardless of the type of email client. 

Note
A note may be attached to almost any marketing object for many different 
purposes. Notes, once attached, are not deleteable.

Note Type
These are organization-defined types to used to categorize notes.

Page
A HTML page viewed in a browser.

Query
An SQL statement that returns records.

Record
A collection of related Fields. All of the fields in a Record contain data relating to a 
single item.

Response
Any communication received back from a customer or prospect. Responses may be 
saved in Oracle Interaction History.

Structured Query Language (SQL)
Sometimes pronounced "Sequel", Structured Query Language is a standard 
language for querying, or asking questions of, a database.
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Subtab
Some tabs have further divisions called subtabs. Subtabs, if any, are displayed 
horizontally underneath the tabs.

Summary Page
Summary pages, which are a list of marketing objects, appear under many tabs and 
subtabs. To view a marketing object's details, click the object's name.

Tab
Main divisions within the user interface of Oracle Marketing Online.

Template
An email composed of text, graphics and merge fields used to create emails which 
are customized to the individual recipient. 
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Fulfillment Services APIs

The APIs for Fulfillment Services provide a number of procedures for general 
fulfillment actions. These procedures are part of the PL/SQL package, AMF_
FULFILLMENT_PUB.

The procedures which make up the Fulfillment Services APIs are:

Create Fulfillment API
This API processes both electronic and physical fulfillment requests. For physical 
collateral, an order in Order Management is created. For electronic collateral, an 
email will be sent out. This API also maintains request history.

This API requires the three type declarations and two table types defined below.

Procedure Name
Create_Fulfillment

Current Version
1.0

Parameter Descriptions

Table 6–1 IN Parameters

Parameter Type Description

p_api_version NUMBER 1.0

p_ini_msg_list VARCHAR2 To initialize messages if any

p_commit VARCHAR2 To commit or not
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Create Fulfillment API
Type Declarations

p_order_header_rec order_header_rec_
type

The record which contains all the request 
information

p_order_line_tbl order_line_tbl_
type

Contains the information of each recipient at 
order line level with shipment details

p_fulfill_electronic_rec fulfill_electronic_
rec_type

Contains information of electronic 
fulfillment

p_request_type VARCHAR2 P for physical fulfillment or E for electronic 
fulfillment

Table 6–2 OUT Parameters

Parameter Type Description

x_return_status VARCHAR2 Returns the status of the API

x_msg_count NUMBER Returns the count of the messages

x_msg_data VARCHAR2 Returns the message data

x_order_header_rec ASO_ORDER_
INT.order_header_
rec_type

x_request_history_id NUMBER Returns the unique id of the request that is 
created. This ID can subsequently be used to 
track the status of the request using the 
request history page. 

Table 6–3 Order_Header_rec_type Definition

Parameter Type Description

cust_party_id NUMBER Requestor Party ID

cust_account_id NUMBER Requestor Customer Account ID

sold_to_contact_id NUMBER Recipient ID

inv_party_id NUMBER Invoice to Party ID

inv_party_site_id NUMBER Invoiced Party Site ID

ship_party_site_id NUMBER Ship to Site ID

Table 6–1 IN Parameters

Parameter Type Description
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Create Fulfillment API
Order_line_tbl_type Definition
TYPE order_line_tbl_type IS TABLE OF order_line_rec_type INDEX BY BINARY_
INTEGER;

quote_source_code VARCHAR2 Source code of the campaign to which 
collateral is associated

order_type_id NUMBER Standard Order Type

employee_id NUMBER Telesales Agent ID

Table 6–4 Order_Line_rec_type Definition

Parameter Type Description

ship_party_id NUMBER Recipient Party ID

ship_party_site_id NUMBER Recipient Party Site ID

inventory_item_id NUMBER Collateral ID

quantity NUMBER Number of Collaterals

ship_method_code VARCHAR2 Shipment Method

uom_code VARCHAR2 Unit of Measure

line_category_code VARCHAR2 Line Category

disposition VARCHAR2 Disposition

language_code VARCHAR2 Language Code

content_name VARCHAR2 Content Name

content_type VARCHAR2 Content Name

expire VARCHAR2 Flag to indicate whether the record has 
expired.

Table 6–3 Order_Header_rec_type Definition(Cont.)

Parameter Type Description
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Create Fulfillment API
Table 6–5 Fulfill_electronic_rec_type Definition 

Parameter Type Description

template_id NUMBER Refers to the template used for the electronic 
request. Foreign key to the table IBC_
Content_items. Each template is associated 
with a bind query.

p_version_id NUMBER Holds the version number of the template. It 
is Null then take the latest version of the 
template.

object_type VARCHAR2 Refers to the JTF objects. Foreign key to the 
column object_code in the table jtf_objects_b.

object_id NUMBER Refers to the JTF object id.

requestor_type VARCHAR2 Refers to the type of requestor: P for Party 
and R for Resource.

requestor_id NUMBER Refers to the id of the requestor.

server_group NUMBER Refers to the server group. Foreign key to 
the column server_group_id in the table 
amf_server_groups_b.

schedule_date DATE:=SYSDATE Refers to the date when the request is to be 
processed. If the date is less than the current 
date then it is substituted to the current date.

media_types VARCHAR2 Refers to the media where the electronic 
collateral will be sent. It is E for email, F for 
fax and P for print. At present, only email is 
supported

active VARCHAR2 Flag to indicate whether the request is it to 
be archived. At present all requests are 
archived. 

log_user_ih VARCHAR2 Flag to indicate whether to log user 
interaction history. 
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Create Fulfillment API
request_type VARCHAR2 Refers to the type of request. The following 
values are available:

EXECUTE_PER_BIND_VALUE: a list of 
party_ids should be provided in p_party_id. 
The query associated with the template will 
be executed once per party id.

MASS_CUSTOM: the query associated with 
the template will be run using p_bind_
values. All merge fields will be resolved 
from the query results.

MASS_NO_CUSTOM: the query associated 
with the template will be run using p_bind_
values to get the destinations, but the 
template has no merge fields to be resolved.

language_code VARCHAR2 Refers to the language used for the electronic 
request. Validation is done against FND_
LANGUAGES.

profile_id NUMBER Refers to the column mail_profile_id in the 
table amf_mail profiles_b.

order_id NUMBER Refers to the order created for the collateral.

collateral_id NUMBER Refers to the collateral requested.

subject VARCHAR2 Refers to the subject of the requested 
message.

party_id AMF_REQUEST. 
number_tbl_type

Refers to the list of party_ids for which the 
electronic collateral request is to be 
processed. If this is not Null then the input 
parameters -_email and p_fax are ignored. 

email AMF_REQUEST. 
string_tbl_type

Refers to the target email list. If the 
parameter p_party_id is Null, then email 
addresses will be used from this parameter.

fax AMF_REQUEST. 
string_tbl_type

Refers to the target fax number list.

bind_values AMF_REQUEST. 
string_tbl_type

Refers to the bind values associated with the 
bind query of the template.

email_text VARCHAR2 Ignored. Refers to the text of the email.

content_name VARCHAR2 Ignored.

Table 6–5 Fulfill_electronic_rec_type Definition (Cont.)

Parameter Type Description
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Reschedule Fulfillment API
AMF_Request.number_tbl_type Definition
Type number_tbl_type is Table of 

NUMBER 

Index by Binary Integer;

AMF_Request.string_tbl_type Definition
Type string_tbl_Type is Table of

VARCHAR2(240)

Index by Binary Integer;

Reschedule Fulfillment API
This API reschedules the date and time of an electronic request. At this time, only 
electronic fulfillment requests are supported.

Procedure Name
Reschedule_Fulfillment

Current Version
1.0

Parameter Descriptions

content_type VARCHAR2 Ignored.

source_code VARCHAR2 Source code of the marketing object. The 
default value for this field is Null

source_code_id NUMBER Unique identifier of the source code from 
source_code table. The default value for this 
field is Null.

Table 6–6 IN Parameters

Parameter Type Description

p_api_version NUMBER 1.0

Table 6–5 Fulfill_electronic_rec_type Definition (Cont.)

Parameter Type Description
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Cancel Fulfillment API
Cancel Fulfillment API
This API cancels the request of an electronic fulfillment.

Procedure Name
Cancel_Fulfillment

Current Version
1.0

Parameter Descriptions

p_ini_msg_list VARCHAR2 To initialize messages if any

p_commit VARCHAR2 To commit or not

p_request_id NUMBER The request id of an electronic request

p_request_type VARCHAR2 E for electronic (only type supported at this 
time)

p_schedule_date DATE New date and time when the electronic 
request should be processed.

Table 6–7 OUT Parameters 

Parameter Type Description

x_return_status VARCHAR2 Returns the status of the API

x_msg_count NUMBER Returns the count of the messages

x_msg_data VARCHAR2 Returns the message data

Table 6–8 IN Parameters

Parameter Type Description

p_api_version NUMBER 1.0

p_ini_msg_list VARCHAR2 To initialize messages if any

p_commit VARCHAR2 To commit or not

Table 6–6 IN Parameters

Parameter Type Description
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Resend Fulfillment API
Resend Fulfillment API
This API enables the resending of a previously sent email to the requestor. This API 
only supports electronic fulfillment at this time.

Procedure Name
Resend_on_Request

Current Version
1.0

Parameter Descriptions

p_request_id NUMBER The request id of an electronic request

p_request_type VARCHAR2 E for electronic (only type supported at this 
time)

Table 6–9 OUT Parameters

Parameter Type Description

x_return_status VARCHAR2 Returns the status of the API

x_msg_count NUMBER Returns the count of the messages

x_msg_data VARCHAR2 Returns the message data

Table 6–10 IN Parameters

Parameter Type Description

p_api_version NUMBER 1.0

p_ini_msg_list VARCHAR2 To initialize messages if any

p_commit VARCHAR2 To commit or not

p_request_history_id NUMBER The request id of an electronic request the 
user wants to send again, to one or more 
recipients on the original list. 

Table 6–8 IN Parameters

Parameter Type Description
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Resend Fulfillment API
Request_tbl_type Definition
TYPE request_tbl_type IS TABLE OF request_rec_type INDEX BY BINARY_
INTEGER;

p_request_table Request_tbl_type This type contains information referring to 
the recipients receiving the resent email.

Table 6–11 OUT Parameters

Parameter Type Description

x_return_status VARCHAR2 Returns the status of the API

x_msg_count NUMBER Returns the count of the messages

x_msg_data VARCHAR2 Returns the message data

Table 6–10 IN Parameters

Parameter Type Description
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Resend Fulfillment API
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Character Sets and Languages

The following characters sets are supported by Oracle Fulfillment Services. Email 
and documents in different languages must be encoded in different languages for 
proper retrieval and display. 

Table 6–12 Character Sets

Character Set Supported Languages

ISO 8859-1 Western European (Albanian, Basque, Breton, Catalan, Danish, 
Dutch, English, Faeroese, Finnish, French, German, 
Greenlandic, Icelandic, Irish Gaelic, Italian, Latin, 
Luxemburgish, Norwegian, Portuguese, Rhaeto-Romanic, 
Scottish Gaelic, Spanish, and Swedish).

ISO 8859-2 Eastern European (Albanian, Croatian, Czech, English, 
German, Hungarian, Latin, Polish, Romanian, Slovak, 
Slovenian, and Serbian).

ISO 8859-3 Southeastern European (Afrikaans, Catalan, Dutch, English, 
Esperanto, German, Italian, Maltese, Spanish, and Turkish).

ISO 8859-4 Northern European (Danish, English, Estonian, Finnish, 
German, Greenlandic, Latin, Latvian, Lithuanian, Norwegian, 
Sami, Slovenian, and Swedish).

ISO 8859-5 Eastern European (Cyrillic-based: Bulgarian, Byelorussian, 
Macedonian, Russian, Serbian, and Ukrainian).

ISO 8859-6 Arabic

ISO 8859-7 Greek

ISO 8859-8 Hebrew
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ISO 8859-9 Western European (Albanian, Basque, Breton, Catalan, 
Cornish, Danish, Dutch, English, Finnish, French, Frisian, 
Galician, German, Greenlandic, Irish Gaelic, Italian, Latin, 
Luxemburgish, Norwegian, Portuguese, Rhaeto-Romanic, 
Scottish Gaelic, Spanish, Swedish, and Turkish).

ISO 8859-10 Northern European (Danish, English, Estonian, Faeroese, 
Finnish, German, Greenlandic, Icelandic, Irish Gaelic, Latin, 
Lithuanian, Norwegian, Sami, Slovenian, and Swedish).

ISO 8859-15 Western European (Albanian, Basque, Breton, Catalan, Danish, 
Dutch, English, Estonian, Faeroese, Finnish, French, Frisian, 
Galician, German, Greenlandic, Icelandic, Irish Gaelic, Italian, 
Latin, Luxemburgish, Norwegian, Portuguese, 
Rhaeto-Romanic, Scottish Gaelic, Spanish, and Swedish).

TIS-620 Thai

EUC-KR Korean

GB2312 Simplified Chinese

BIG5 Traditional Chinese

ISO-2022-JP Japanese

Table 6–12 Character Sets

Character Set Supported Languages
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The following is an alphabetic list of languages supported by the above character 
sets:

Table 6–13 Supported Languages

Afrikaans

Albanian

Arabic

Basque

Breton

Bulgarian

Byelorussian

Catalan

Chinese, Simplified

Chinese, Traditional

Cornish

Croatian

Czech

Danish

Dutch

English

Esperanto

Estonian

Faeroese

Finnish

French

Frisian

Gaelic, Irish

Gaelic, Scottish

Galician

German

Greek

Greenlandic

Hebrew

Hungarian

Icelandic

Italian

Japanese

Korean

Latin

Latvian

Lithuanian

Luxemburgish

Macedonian

Maltese

Norwegian

Polish

Portuguese

Rhaeto-Romanic

Romanian

Russian

Sami

Serbian

Slovak

Slovenian

Spanish

Swedish

Thai

Turkish

Ukrainian
Character Sets and Languages D-3



D-4 Oracle Fulfillment Services Implementation Guide 


	Contents
	Send Us Your Comments
	Preface
	Intended Audience
	How This Guide is Organized
	How to Use This Guide
	Related Documentation and Resources
	Additional Product-Related Documentation
	Support

	1 Fulfillment Services Overview
	1.1� Introduction
	1.2� Key Features
	1.3� Fulfillment Users
	1.4� Fulfillment Servers
	1.5� Content
	1.6� Queries
	1.7� Key Concepts
	1.8� Key Benefits

	2 Technology Requirements and Dependencies
	2.1� Technology Requirements
	2.2� Required Dependencies
	2.3� Optional Dependencies

	3 Implementation Overview
	3.1� Implementation Description
	3.1.1� Profile Options
	3.1.2� Lookups
	3.1.3� Administration Options

	3.2� Implementation Sequence

	4 Implementation Steps
	4.1� Implementation Task Sequence
	4.2� Set System Profile Options
	4.3� Enter Lookup Values
	4.4� Set up the Fulfillment Administrator
	4.5� Create Fulfillment Server Groups
	4.6� Configure Fulfillment Servers
	4.7� Start the Fulfillment Server
	4.7.1� Windows NT Setup
	4.7.2� Unix Setup (recommended)

	4.8� Configure Email Servers
	4.9� Create Mail Profiles
	4.10� Create Queries
	4.11� Create Templates
	4.12� Create Attachments

	5 Administration Setup
	5.1� Creating Categories
	5.2� Creating Custom Setups
	5.3� Deduplication Rules for List Import

	6 User Setup
	6.1� HRMS Navigation
	6.1.1� With Full Oracle HRMS
	6.1.2� With Shared Oracle HRMS

	6.2� Create the Employee
	6.3� Create the User
	6.4� Enabling the Application Switchboard

	A Acronyms
	B Glossary of Terms
	C Fulfillment Services APIs
	Create Fulfillment API
	Reschedule Fulfillment API
	Cancel Fulfillment API
	Resend Fulfillment API

	D Character Sets and Languages

